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To install Snow Leopard, insert your installation disk and double-click Install Mac OS X,
then follow the onscreen instructions.

aNO (=) Mac OS X Install DVD =
| 2 3 items, 16 KB available i
- |
» |
Install Mac OS X
OO0 Install Mac OS X
Install Mac OS X
To set up the installation of Snow Leopard, click Continue.
Click here to repair —_—  Guimes. ) Go Back (Continue )

your startup disk or
restore from a backup.

To restore your computer’s software, see the user guide that came with your computer.



When you're ready, click Install to begin installing Mac OS X Snow Leopard. When the
installation is finished, your computer will restart.

OO0 Install Mac OS X

Install Mac OS X

Mac OS X will be installed on “Macintosh HD"

Macintosh HD

€ i | \
(_ Customize... ) GoBack ) Install

Click Customize if you want
to change what’s installed.

For additional information, see the Instructions folder on your installation disc.



Meet Snow Leopard

www.apple.com/macosx
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The Dock includes the Documents, Downloads, and Applications stacks. Stacks provide
a convenient way to get to documents and applications. To create a stack, drag a folder
to the Dock.

Green Grocery City Poster

@,

Italian Architecture Surfing Open in Finder

When you click a stack,
the items in it appear in
a grid, fan, or list.



Downloads stack
Items you download in Safari, Mail, or iChat always go to the Downloads stack so that
you can find them quickly.
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= The latest download

appears here.
L4

Click the Downloads stack to
see items you've downloaded.

8 Desktop



Stacks automatically appear as a fan or a grid, based on the number of items in the stack.
You can specify which style you want to use and change the stack’s sort order.

v Name
Date Added
Date Modified
Date Created
Kind

Folder
Stack

Fan

Grid

List
Automatic

Remove from Dock
Show in Finder

Open “Downloads”

To customize a stack, press the
Control key and click the stack’s icon.
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Use Exposé from the Dock at any time to quickly view the windows open in an
application and bring one to the front.

O & 4 0 TuclSiim Q

Finder fie Edit View Go  Window Help

— To see a full-size
preview of a
window, highlight
it and press the
Space bar.

Click and hold the application icon to
view open windows in Exposé.
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Finder
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Pages Document
Keynote Document
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Cover Flow lets you flip through your movies, presentations, PDF files, and more in
large-size previews.

. NeXé) (] Documents

(<[>] B ~ Q ; Click this button
' for Cover Flow.

0

¥ DEVICES
'_:i Macintosh HD
Eipisk
E Backup -
(%) Remote Disc &
¥ SHARED
I Mom’s Mac
[H ill's MacBook
|8 pad’s PC
Al

= Move the pointer over

e i g MILEA REAL ESTATE . ) an item to play a movie

@& uinsinescr [ : | orseethe pages of a
(«)X(~) document, for example.

:,A. Applications
B Documents
¥ SEARCH FOR
Milea Real Estate
(5 Today
(L) Yesterday

‘;L, Past Week

Drag the slider to

- 2:: :;na?es Name A Date Modified Size Kind ﬂ . h h
ﬁ 5 D:L:ms & Allen Fishing July 16, 2009 10:44 AM 117.2MB  TIFF image 1Y) t rougn your

= At the Lake July 16, 2009 2:42 PM 117.2 MB TIFF image

B Canoeing July 16, 2009 2:40 PM 117.2 MB TIFF image dOCU mentS.

E] City Symphony Poster June 28, 2009 2:35 PM 905 KB Portable Document Format (PDF)

% Collin Rafting Trip Yesterday, 7:05 PM 475 KB Numbers document

m Family September 16, 2009 12:46 PM 49.9 MB TIFF image

2 Family Newsletter Yesterday, 6:30 PM 471 KB Portable Network Graphics image

% Green Grocery Newsletter Yesterday, 6:32 PM 410 KB Pages Document

=+ Milea Brochure April 22, 2009 1:09 PM 7.2 MB Pages Document

Milea Real Estate Yesterday, 6:32 PM 33.2 MB Keynote Document i

= School Newsletter Yesterday, 6:33 PM 262 KB Pages Document v

1 of 15 selected, 183.83 GB available A4
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Sidebar

The Finder sidebar makes it easy to get to folders on your computer, shared computers on
your network, and your saved searches.

¥ DEVICES

|Z] Macintosh HD
E ipisk

@ Backup

@ Remote Disc

»

»

¥ SHARED Shared computers
B Mom's Mac available on your network
JL. Bill's MacBook automatically appear here.

® Al

¥ PLACES
Desktop
_(ﬂ annejchnson
ﬁ Applications
Eﬁ Documents

¥ searcH ror ——————Commonly used searches are
(Y Today included in the sidebar, and you
k? Yesterday can add your own searches.
() Past Week
|&] All Images
All Movies
|&] All Documents

——

14 Finder



In a Finder window or the menu bar, use Spotlight to search for items on your computer. If
you use the same search often, save it in the Search For section of the sidebar.

\&l Searching “Documents” =3

(=[ofl [o] (%] Q schoo trip —— Type your search here.

Back View Quick Look Action Search

¥ DEVICES Search: This Mac @] 5 Shared
:4 Macintosh HD
E ibisk
B Backup
( ‘ 'Remote Disc

save )(+) |

Click Save to add a
Smart Folder to the
sidebar.

¥ SHARED
I8 Mom’s Mac
& gill's MacBook
& pad’s PC
@ AL

¥ PLACES
E Desktop
ﬁ‘} annejohnson
77)! Applications
ﬁ Documents

See your search results
in Cover Flow.

¥ SEARCH FOR Science Report
(O Today Pages Document
(L) Yesterday
" Past Week
15 All images ime Date Modified Size Kind
(& All Movies ] Away from School Jul 16, 2009, 2:40 PM 111.8 MB TIFF image
| All Documents # Fishing Trip Jul 16, 2009, 10:44 AM 111.8 MB TIFF image ‘
Letter to Parents Sep 3, 2009, 4:13 PM 136 KB Pages Document |
L] Science Report Sep 5, 2009, 2:11 PM 192 KB Pages Document
&l Trip to the Lake Jul 16, 2009, 2:42 PM 111.8 MB TIFF image
= Welcome Back Aug 24, 2009, 6:01 PM 256 KB Pages Document ‘

£} annejohnson + ({3 Documents + & Science Report |

10f 6 selected 4




Shared computers on your network automatically appear in the sidebar so that you can
quickly find documents they contain.

®enon (I Bill's MacBook =
(]>] —— Search for documents
| Back View Quick Look  Action-

v oevices on shared computers.
_:i Macintosh HD
H ipisk
mvBackup

=
(%) Remote Disc &

¥ SHARED
IS Mom's Mac
=UBill's MacBook
[ pad’s rC
@ All..
¥ PLACES
E Desktop
Q annejohnson
'}\_r Applications

E‘[] Documents
¥ SEARCH FOR

(5 Today

(1Y) Yesterday

(L) Past Week L T W 0D =S @I ]

B stepaes: - A Date Modifed — Get immediate access

1] All Movies & Allen Fishing July 16, 2009 10:44 AM 117.2MB  TIFF image

& All Documents B Canoeing July 16, 2009 2:40 PM 117.2MB  TIFF image to the PU b| iC fOIder on
% Collin Rafting Trip Today, 11:52 AM == Numbers document
B Family Newsletter Yesterday, 6:30 PM 471 KB Portable Network Graphics image
= Surf Instructor July 26, 2009 4:58 PM 49.9MB  TIFF image a ny S ha red comp uter.
% surfing September 16, 2009 12:46 PM 49.9MB  TIFF image
@ Surfing Hawaii July 26, 2009 3:01 PM 117.2MB  TIFF image
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Use screen sharing to get to the desktop of shared computers on your network. You can
monitor use, change settings, and much more all from your computer.

ano || Marta's Mac

Look  Action. Search.

A

Select the computer in

veices [ Connecied a5 GUest B Yoneariey  the sidebar and then

:] Macintosh HD .

B oisk click Share Screen.

(2} Backup

’% ! Remote Disc
¥ SHARED

B Mom's Mac

HH gilr's MacBook
|8 pad’s PC _— N
M Marta’s Mac Marta's Mac =

&% annejohnson
y‘-\_ Applications
B} Documents

choose View >
Show Toolbar
from the menu.

¥ SEARCH FOR
(L) Today
\L‘ Yesterday
(L) Past Week
| All Images
& All Movies
| All Documents

MOBILENE GALLERY
" Graduation
" haly
8 " surfing

B @ ¢ Q@

You see the
desktop of the
other computer
- in a window.

.......

;;;;;;

Speech  Startup Disk Time Machine  Universal

R~

To use all of your screen, click
the Full-Screen button.

Bar. _________—Tosee the screen
¥ PLACES 4 = Thu3osipm Q | .
I Deskeop sharing toolbar,
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You can share your files, your website, your screen, and much more with other computers
on your network. To start, open System Preferences and then click Sharing.

eaNn Sharing

Computer Name: Anne Johnson's MacBook Pro

Computers on your local network can access your computer at: Anne- -
Johnsons-MacBook-Pro.local Edit...

On  Service @ File Sharing: On
@ DVD or CD sharing Other users can access shared folders on this computer,
M  Screen Sharing and administrators all volumes, at afp://17.244.41.162/

o or “Anne Johnson's MacBook Pro”.

™ Printer Sharing

[ Scanner Sharing Shared Folders: Users:

g Web Sharing {&]Anne John...blic Folder 4 Anne Johnson Read & Write 3
] Remote Login (L Cathy's Public Folder A8 staff Read Only

]  Remote Management [[Marta's Public Folder 2t Everyone Read Only

"] Remote Apple Events (L Susan's Public Folder |.

) Xgrid Sharing
5 etoon Shang Click this Add (+) button
[+]-] to select users and groups
who can share your files.

P o (@)
Click the lock to prevent further ghanges.

Click this Add (+) button
to select any folder you
want to share.



Back to My Mac

With your MobileMe subscription, an Internet connection, and Back to My Mac and

sharing turned on, you can access any of your computers from anywhere on the Internet.

mobile

MO | iPod touch.

ﬁ MobileMe is the simple way to keep everything in sync on your Mac, PC, iPhone, and

| Account  Sync iDisk |

My Mac }-———

@ Back to My Mac: On

Using Back to My Mac you can access this computer, and services such as file sharing and
screen sharing, from your other computers that have Back to My Mac enabled.

m Click Stop to turn off Back to My Mac for this user. You will no longer be able to access this
- computer from other computers using Back to My Mac.

Use Sharing preferences to turn on services like file or screen sharing to use
with Back To My Mac.

Use Energy Saver preferences to turn on “Wake for network access" so that
Back to My Mac can wake this computer from sleep. Your must be

Open Sharing...
(_ Open Energy Saver... )

on a network with a Time Capsule or compatible AirPort base station.

Back to My Mac computers —
appear in the sidebar.

Back to My Mac is
on automatically.

¥ DEVICES
= Macintosh HD
E ibisk
g Backup —
(5)Remote Disc &

¥ SHARED

i Mom's Mac
=| Bill's MacBook

W Marta's Mac
@ An.

¥ PLACES
B3 Desktop
ﬁ} annejohnson
ﬁ Applications
B Documents

¥ SEARCH FOR
@ Today
© Yesterday
@ Past Week

Desktop

Library

Pictures

Documents

Movies

Public

w

Downloads

n

Music

W

Sites

Finder
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Quick Look
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You can use Quick Look in the Finder, Time Machine, and Mail. To view an item in
Quick Look, select it and then press the Space bar.

¥ DEVICES
=i Macintosh HD
E ibisk
2} Backup —
(%) Remote Disc &
¥ SHARED
I Mom’s Mac
[ gill's MacBook
8 pad’s PC
@A
¥ PLACES
E Desktop
@ annejohnson
-ﬁg Applications
B Documents
¥ SEARCH FOR
(Y Today
(1) Yesterday
() Past Week
| All Images
(& All Movies
| All Documents

&/ Allen Fishing

& Atthe Lake

B Canoeing

[¥ city symphony Poster
& Collin Rafting Trip

= Family

E Family Newsletter

_‘_: Green Grocery Newsletter

& Milea Brochure
L1 Milea Real Estate
= Schoal

[_1 Documents

THE COLLIN FAMILY

It's been a busy year for t|

* A |Date Modified

July 16, 2009 10:44 A
July 16, 2009 2:42 PM
July 16, 2009 2:40 PM
June 28, 2009 2:35 Ph
May 21, 2009 7:05 PN
September 16, 2009 1
May 21, 2009 6:30 P!

May 21, 2009 6:32 PN
April 22, 2009 1:09 P
May 21, 2009 6:32 PN
May 21 2009 £33 PN

full-screen preview.

= Click the Quick Look
button in the Finder
window toolbar.

Family Newsletier

The bop e Carpng ey, 1od bting Lo

o ek tha ey cn hels i By,

Click here for a
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When you view documents in Quick Look, you can flip through each page of your
document or view each slide of a Keynote presentation.

Italian Architecture

COLOSSEUM

ELEVATION DETAIL SHetHbuM

MAENIANUM

Each slide of a Keynote
presentation appears here.



You can use Quick Look to view several items at once. To automatically scan through the
items, click the Play button.

Click an item in the
index sheet to view it.

“«p > |E" @

Click the Index Sheet Click the Camera button
button to view all the items. to add a photo to iPhoto.

23
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Time Mac
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To start using Time Machine, just connect a FireWire or USB disk or a Time Capsule to your
computer, and then click “Use as Backup Disk”in the dialog that appears.

— When you turn on Time
Machine, it backs up your
computer to the disk
you've selected.

25



26

Easily find a missing document by seeing how your desktop looked in the past. Time
Machine does a backup each hour of the current day, and then saves daily backups.

Type in the search
field to look for
a document.

Click the back
arrow to go back

‘ in time.
Use Quick Look to Browse items in When you find the
check a document your backup using document, select it and
before you restore it. Cover Flow. then click Restore.



To set Time Machine options, open Time Machine preferences. You can select a different
backup disk or specify folders or disks you don’t want to include in your backups.

800 Time Machine

@ Name: BackUp

Available: 182.2 GB of 232.9 GB

)
Oldest Backup: 6/16/09 4:57 PM
| Change Disk... | .ot Backup: 8/27/09 3:08 PM
Options... | Next Backup: 8/27/09 4:13 PM
|

Ti me Machine Time Machine keeps
» Hourly backups for the past 24 hours
» Daily backups for the past month

* Weekly backups until your backup disk is full
The oldest backups are deleted when your disk becomes full.
g Show Time Machine status in the menu bar

0
d Click the lock to prevent further changes.

Click Options to select items
you don’t want to back up.

27



Exchange
Mail, iCal, and Address Book support Microsoft Exchange to

access your work email, calendars, and contacts.

S/13/09 6197 %
__S1318._ edomic

1° Sales Forecast
Date: May 1,2009 1:42:17 AMPOT
Yo fric Ledoux
P& 2Amachments. 789KB (Save =) ( Ouekiosk )

100K at,

28 Exchange



To start using Exchange, just enter your Exchange email address and password, and Mail
does the rest for you. Snow Leopard automatically sets up iCal and Address Book, too.

— Use Spotlight to search

your Exchange messages.

eann Inbox — Exchange (23 messages, 1 unread) (]
%) Q & Do o E O —
 Get Mail _ Delete  Junk  Reply Reply All Forward NewMessage Note To Do _ Search =
MAILBOXES ® | 9 From Subject Date Received Y]
- Hector Rodriguez Quick Favor 5/13/09 3:17 PM ~
Inbox Tribeca Grand Hotel Hotel Reservation 5/13/09 5:18 PM
e MobileMe Darlene Weaver Job Opening in Marketing 5/13/09 5:26 PM
- Gmail Curtis Neil TPS Report 5/13/09 5:27 PM
= Lynette Saito Contact Info 5/13/09 5:28 PM
— Chuck Brady Ride from the Airport 5/13/09 5:30 PM
Drafts Leah Williams Building Map 5/13/09  5:34 PM
— Matt Richards Sales Forecast 5/13/09 6:17 PM
-~/ Sent Emily Cowan Sales Presentation 5/13/09 6:19 PM
= Gita Kumar Partner Meeting e o e

g Trash —

From: Matt Richards
Subject: Sales Forecast

SMART MAILBOXES
= Date: May 1,2009 1:42:17 AM PDT

Accept calendar
invitations in Mail.

@ Project email To: Eric Ledoux
P & 2 Attachments, 789 KB ( Save v ) ( Quick Look )
REMINDERS
Notes Eric,
Here's the latest sales breakdown for 2008. We should take a closer look at all the data. Let's plan to meet this Friday at 8am. I've also attached an updated
¥} To o version of the financial forecast for you to take a look at.
EXCHANGE Matt Richards
: Payroll
| Personal
L: 100 “ Americas
Q Projects 80 B Asia
L: Recruiting 60 B e “ Europe
: RSS Feeds 40 = 3 3 B - “ Africa
20 “ Australia
Sales Forecast oot (739 k&)
+ @ Iil

Use Quick Look to
preview attachments.

See your Exchange folders,
notes, and tasks in Mail,
and use smart mailboxes
to locate special ones.

29



iCal

With iCal set up to access your Exchange server, you can accept and propose meetings
with other Exchange users. You can also manage your tasks.

— Access your Exchange
calendars alongside
your personal calendars.

Propose meetings,
schedule conference
rooms, and invite
attendees from your
Global Address List.

Receive and respond to
meeting invitations.

30 Exchange



Address Book gives you complete access to all your Exchange contacts, including your
Global Address List.

(N NG] . Address Book
N =0 =) Q —— Type here to search your
Group Name .
7] Al Contacts M Anne Johnson Anne Johnson Global Address List.
[l Exchange || Cindy Paxton A
[ 0n My Mac || Darlene Weaver
» [] Exchange | Enrique Porter
[Z3] Contacts [ ]Jimmy Foster
|&ZEngineering |- Melissa Long (555) 555-5555
[l Finance |- Chuck Brady annejohnson1@me.com
%] | Gita Kumar —— Update all the
SliPersonal \iSydney Bailey Cupertino, CA 95014 information about your
22Ul Review Team — - .
i Last Import Excha nge contacts In
Address Book.
= 5t »

Your Exchange contacts
appear with your other
Address Book contacts.

31
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Safari




Safari identifies your favorite sites and displays them in a stunning preview that makes it
easy to identify the sites you want to open.

enNnn : Top Sites

Click here to view
Top Sites.

To open a site, just
click its preview.

A star indicates
that a site has been
updated recently.

Click here to customize
Top Sites.

33
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Use full history search to flip through full page previews of webpages you have visited
and easily find one even if you don't remember the details of the site.

anm Top Sites

Lealo W40 @ co o this address ¢ Q- Goog

Ehe Netw York Eimes

Surfers’ Paradise

Strong winier somms in the Norh Pacitc can creal huge beakig waves
Fousands of mikes away al Mavercks, e e of an 6k surfing compettion
i Aok at the mak

—— So you can see webpages
\ the way they looked when
you opened them, Safari
stores the text and images
of every page in your
history for one month.

To search your history,
click here and type
a word or two.



As you enter web addresses and searches, Safari quickly finds the best results and
provides other suggestions to help.

".«:( -—' @15 nnilifl.vww a;fplejom I ) c:@- apple ) .
1B aple Yahoo! GoogleMaps YouTube Wikipedia Newsr popalrs I 1 Safari offers excellent search

apple store

e o s e s suggestions, courtesy of

apple iphone

Google Suggest and your
i recent search history.

cheap tickets
restaurants

iPhone 3G (s

The fastest, most powerful iPhone yet.

movies

Find “apple® on This Page (9)

Top Sites

Apple
Apple - Macbook Pro - Meet the new Macbook Pro f...
w  Apple - Downloads

Apple - iPhone

Apple - iPad + iTunes

Apple - QuickTime

Hot News Headlines

Phone OS5 3.0 Software Update Th

Safari completes
the address with the
Top Hit and suggests

others from your

history and bookmarks.



iChat

Make your chats more fun using video effects such as
backdrops. Show off your work with iChat Theater.

36 Chat



Use video backdrops with your chats to “be” anywhere in the world. iChat includes movies
and photos that you can use, and you can add your own.

Select a video backdrop
and then step out of the
picture for a moment.

e
Eiffel Tower

Click Effects to select
a video effect.

(€] Add your own movies
or photos to use as a
video backdrop.

37



While you're in a video chat, you can select video effects to make your chats fun and
interesting.

Click the effect in the center
for the original view.

Video Effects
£

Black and White

=
Original Color Penci

] o
=T = 4 t | “
i ks | v ﬁ .

Thermal Camera Pop Art

Click any effect to use it.

38



To show photos, movies, or presentations in a video chat, start the chat and then drag the
file or files to the chat window.

AN A Video Chat with Ted Clark

UTILITY COSTS

2 o

Utility Costs - 2007 to 2008

Sl Ay Se 0a Now De °

May

‘Nl d;
e See how your

vy Gos y o ' presentation looks
o e : to your buddy.

Effects

Control your
presentation here.

39



Screen sharing lets you take control of a buddy’s computer to show how to do something,
rather than just explain it.

& Finder File £dit_View Go Window Meip O ¢ T e G Thul020AM Q

. - , Click to switch
T = - % N screens. To copy
; a document to
this computer,
drag it here.

eNno My Home
Anne Johnson — |
,0 Available v o ﬁl, . ,i

@ Bill James &1
\

O Gita's SMS oX
@ Marta Ruiz <] i ‘
® Mei Chen

s Ted Clark

@ Juan Chavez

Select a buddy with
video chat capability,
and then click the

Screen Sharing button.  EiA=IEialy



Tabbed c

Use tabbed chats if you have a lot of chats. To do so, open the Messages pane of iChat
preferences, and then select “Collect chats into a single window.”

hats

AIM IM with Ted Clark <tclark3@me.com> 8/29/09 10:17 AM

i Marta Ruiz (i Ted, how are you? A
L When is your ... ) 2
! Mei Chen & @
o Y © ,
" Are you at school? |
%@l & “'m studying, but will be finished soon
Stop by when you are done " A
& rlwlll. Icanmeetvuu there and we can j
get some lunch
See the latest reply
from your buddy.

Click a chat to
return to it.

iChat 41



QuickTime X

QuickTime X debuts a new QuickTime Player with a simple
design for viewing, trimming, and sharing your movies.

42 QuickTime X



QuickTime Player provides simple controls to play a movie. So your movie can take center
stage, the controls fade from view.

B Paris.mov

Click here to watch
your movie in full
screen.

To see the controls, just move Click here to share your movie
the mouse pointer over the or to trim it.
movie window.

43
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Capture movies using QuickTime Player and the iSight camera built into your computer.

To record a movie, choose
File > New Movie Recording,
set up your shot, then click
the record button.



Trim your movie to just the part you want to use, then share it with iTunes to use on
your iPhone, iPod, or Apple TV. You can also share your movie in a MobileMe Gallery
or on YouTube.

LET

your movie to iTunes
cose ses based on where you will viaw your movies.

Drag the ends of the trim
area to select the part of the
movie you want to keep.

<) iPhone & iPod ) Apple TV  Computer
Size: 29 MB Size: 9.7 M8 Size: 16.8 M8

Comptible with: iPhone, iFods, Apple TV, and Computers | Cancel ) s

—

Select the size appropriate for where
you'll view the movie.

45
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Spaces




Turn on spaces in Exposé & Spaces preferences, and then press Fn-F8 to show your spaces.

To organize your windows, drag them from the current space to a different space.

COLOSSEUM

ELEVATION DETAIL

Drag windows you want
to use together into the
same space.

47
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To switch between spaces, press Control + [an arrow key]. To go directly to a space,
press Control + [a number key]. Arrange the order of spaces to suit your needs.

Drag spaces to
reorder them.

R

COLOSSEUM
EL ETAIL

Use keyboard shortcuts
to quickly switch
between spaces.




After you turn on Spaces, you can add other spaces. You can also assign applications to
each space so that the application’s windows always open in the same space.

oo Exposé & Spaces

a

! Exposé | Spaces
Spaces lets you organize your windows into groups to reduce desktop clutter.

M Enable Spaces "1 Show Spaces in menu bar

Rows: @ @

Columns: @ @

Application Assignments

— Add rows and columns to
create the spaces you need.

w| Space
I Photo Booth.app Space 3
€ iChat.app Every Space
3% iCal.app Space 4
\.| Address Book.app Space 3

4[]
Heyboard and Mouse Shortcuts (for additional shortcut choices, press Shift, Control, Option, or Command)

To activate Spaces: | F8 -+ ]-| 9

-

To switch between spaces: | ~ Arrow Keys

To assign an application,
choose a space here or use
the shortcut menu in the Dock.

To switch directly to a space: | ~ Number Keys ]J

When switching to an application, switch to a space with open windows for the application

(€]

Choose keyboard shortcuts
that work best for you.

Click the Add (+)
button to assign
applications to spaces.
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Mail
Use Apple-designed stationery to send gorgeous email
messages complete with photos.

Happy Birthday to You

I know you have a lot planned for your birthday and you.'ne Thank Y s
going to have a lot of fun. Look forward to seeing you tonight. ) ou!
Thanks for the lowers, the wonderful thoughts,
Have a great day! and all the fun we had,
Have a great day
Tracey - s it
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Stationery
When you create a message, select stationery to give it the perfect style whether the

occasion is fun or formal. Including photos is easy using the Photo Browser.

Click to see the

stationery you can use.
Cc:
El Subject:
i o [euwm .
nuncemenls ;i o Se|eCt da type Of Statlonery,
saone _— B and then click the
entiments Air Mail Bamboo Tack Board Doodles .
statlonery you want to use.

)
| & iPhoto

|8 Events

Ana = — Select photos from
| Summer Tri
il iPhoto, Photo Booth,
o el or Aperture.
Fun, Fun, Fun .

We're having a great time on our vacation. Yesterday we went to
beach in the morning, then we had lunch at a little restaurant in th
village. Excellent food! Later, we took a leisurely two hour horse
ride through the country side. This is sure a beautiful place. After
headed back to the beach for reading and an afternoon siesta unde

the shade of the umbrella. The gentle ocean breeze was so calmin

—— Locate photos here,
and then drag them to
your message.

balnl

(] Q- 18 items

4
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Keep all your notes and to-do items in one place. Jot down reminders, shopping lists, and
information you need. Include pictures, URLs, and attachments with your items.

en ﬁ Notes (9 notes)

MAILBOXES | Subject
T Inbox @ projes
-, Drafts @ |7 Workitoms
-/ Sent Shopping
© Trash _-_ Vinner plans

3 Reading quotes

™ Present ideas

V. REM!ND[KS

./ ToDo {10

New project

set up meeting with Juan
need guest list
where should we have it?

V¥ RSS
Apple Hot News | €[

need a caterer

May 4, 2009

) call Bill for caterer's name

need this info to pick a date for the event
will it be formal or casval?

Ted says the art gallery is a nice place for parties
(1 5/13/09 stop by gallery o discuss
Il

To Do Optians

Wl & Due Date  5/13/2009
© Alarm
M Priority Medium 3

Calendar Wl calendar ¢

See your notes and to-do
items in the Reminders
section of the sidebar.

Click to create a
note or to-do item.

To create a to-do item,
select text in the note
and click To Do.

Click to set options for
the to-do item. Items
automatically appear in iCal.



Data detectors

You can turn dates in your email messages into iCal events. You can add names, phone
numbers, and addresses to your contacts. You can even map addresses in Safari.

Join the Paljty — Inbox

Help Us Celebrate!
Mary's Birthday
Sunday, October 4, 2009. 2:00 PM

Children's Playground
1234 Main Street

amytown CA0R014 B0 - te New:Contact

Add to Existing Contact...
RSVP

telark3@me.com
(555) 555-5555

Show Map
Large Type

i
N

Move the pointer over the
date, name, or address, and
then click the triangle to
choose an action.

Mail
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Parental Controls
Give yourself peace of mind. Manage the time your children
spend on the computer and what they do there.

Weekday time limits
Sisil Allows access to this computer Monday th: h
4 susan =x .| specified number of hours only. WENRLgn Eniday fotihe
3 hours a day
™ Limit computer use to: =
O S R0 o
Weekend time limits
“=u  Allows access to this computer Saturday and Sunday for the To turn on 1] Is, select a user
" specified number of hours only.
S hours a day
4 Limi computer use to: ===
30 minutes 8 hours

/\ Bedtime

“ Prevents access to this computer during the specified hours.

k J ™ Manage parental controls from another computer

7 - — To access this computer to change parental control
" 0:00 PM | : settings. you need the
# school nights: ~ 9:00 PM (3] to 9:00 AM 8] Senings. vouneed the name and pasword of an
Sunday - Thursday S
| # Weekend: 11:00 i (3] to 12:00 AM (2]
Friday and Saturday
£33 ‘
[P Click the lock to prevent further changes.
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Manage when your children use the computer by setting time limits for weekdays,

weekends, and nights.

enn Parental Controls

= { System  Content  Mail & iChat ' Time Limits = Logs )=

»d Marta Weekday time limits
Allows access to this computer Monday through Friday for the
4= Susan " specified number of hours only.
3 hours a day
™ Limit c use to: )
30 minutes h
Weekend time limits
Allows access to this computer Saturday and Sunday for the
specified number of hours only.
5 hours a day
B8 Limit comiputer use fo: Semmmmggrm—
10 minutes h
7, Bedtime
Prevents access to this computer during the specified hours.
™ school nights: 9:00 PM fa to  9:00 AM @
o 3
Sunday - Thursday
¥ Weekend: 11:00 pM (2} to 11:00 AM [3]
- Friday and Saturday

n
d Click the lock to prevent further changes.

— Specify how many
hours a day your child
may use the computer.

— Specify the hours during
which your child may not
use the computer on school

nights and weekends.
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To limit the websites your children can visit on the Internet, click Content and then select
the level of restrictions you want to apply.

enon Parental Controls

= [ System | Content Mail & iChat  Time Limits  Logs -
s B Select this to try limiting
e B access to adult websites.
@ bt Click Customize to specify

Restricts website access to sites with
appropriate content or to a list of websites.

_ _ websites your children can
(O Allow unrestricted access to websites .
(O Try to limit access to adult websi ically and cannot visit.

Customize... )

) Allow access to only these websites

#4 Discovery Kids

@ pos kids —— Select which websites your
€4 HowstuffWorks . ..

#4 National Geographic - Kids Ch||dren can V|S|t_

#% Yahoo! Kids

4 Disney

€4 Scholastic.com
4 Smithsonian Institution
€4 Time for Kids

— 1]

n
[i Click the lock to prevent further changes. @




Protect your children from unwanted communication by specifying who they can chat

with and exchange email with.

N0 Parental Controls

~——| System = Content \Mail&iChat- Time Limits Logs '

Colby
®4 Marta A E Limit Mail E Limit iChat
Limit chat and email exchanges to the
o addresses added to this list.

4~ Susan

Only allow emailing and instant messaging with:

Name Email & Instant Messaging Address
[+ ] Bill James billjames@me.com

[+ | Mei Chan meichan@me.com

|| Gita Kumar gkumar@me.com

[+ ] Ravi Patel ravipatel@me.com

[+ ] Juan Chavez jchavez4@me.com

|| Anne Johnson annejohnsonl@me.com

1+]-]

1 Send permission requests to:

Sends an email to the address you specify whenever the user attempts to
exchange email with a contact who is not in the approved list.

Fo

Ijﬂ Click the lock to preventffurther changes. ®

Click the Add (+) button to
add an address.

Enter your email address to be
notified if your children try to
correspond with someone who
isn't in the list.
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Photo Booth




“Be” anywhere in the world—or out of this world—by using backdrops when you take

a snapshot.

Photo Booth

Select a backdrop, and then
step out of the picture for
| a moment.

Photo Booth

Color Dots ’arth ris“

o
=

19 photos and 2 movies

o EE) EEEE Effects
|azz=EL i A2
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Now you can make a burst of four snapshots. You can export a 4-up snapshot as an
animated GIF to use as your buddy picture in iChat.

Click the 4-up
button.

| é’if\ i’hogo kot;tﬁ

32 photos and 1 movie

When previewing
a 4-up snapshot,
click a frame to
preview that
frame and select
how to use it.



Make a movie of yourself using effects and backdrops. Use your movie as a video greeting,

complete with audio, to send to your friends in an email message.

800 Photo Booth

= = S —— e e == —

Lo Y N — PhotoBooth L
> 3
Ak iy 1
- By o
“)\1“" ~ %,
ik
% )‘/,’v:\ !
—' %
Gk r &y % '
1 ¥ '
(el=r3 (& o
5 »
;g -+ N
4 B g i
- 19 photos and 2 movies .

Click the Movie
Clip button.

When you preview
a movie, move the
pointer over the
image to control
playback.
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Boot Camp
To use a Windows application on your Mac, install Boot Camp
and your copy of Windows. Then you're ready to go.

62 Boot Camp



Install Boot Camp
Open Boot Camp Assistant (in the Utilities folder in the Applications folder) and print the
Boot Camp Installation & Setup Guide. Then create a partition for Windows.

Introduction

The Boot Camp Assistant helps you install Microsoft Windows XP or ‘
Windows Vista operating systems on an Intel-hased Mac ¢

Print the Boot Camp Installation & Setup

Windows. You'll need this document to co ACE .
Create a Partition for Windows

IMPORTANT: Back up your disk before pal
Windows. If you are installing Windows on|
connect the power adapter.

Each operating system requires its own partition on the disk.
Drag the divider to set the size of the partitions, or click one
of the buttons.

. “Macintosh HD” will be partitioned as:

0 @,
& >
Mac OS X Windows
227 GB 5GB
190 GB free

( Divide Equally ) ( use32GB| )

( Print Installation & Setup Guide )

Print this document to
follow the instructions
while installing Windows.

(" GoBack ( Partition )

Drag the divider to
set the size of the
Windows partition.

If you installed a beta version of Boot Camp, you only need to install the new Windows
drivers by switching to Windows and inserting the Snow Leopard installation disc.
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Insert your Windows XP or Windows Vista installation disc and click Start Installation.

Start Windows Installation

Installation.

Ultimate disc.

software for Windows.

Insert your Windows installation disc and click Start

You'll need an authentic 32-bit Microsoft Windows XP Home
Edition or Professional with Service Pack 2 or later, or
Windows Vista Home Basic, Home Premium, Business, or

After you have installed and set up Windows, insert your Mac |nSta” the WindOWS drivers

0S X install disc to install additional drivers and other

when you finish installing
and setting up Windows.

( Quit & Install Later )

[ GoBack ) (Start Installation)

Click when you're ready
to install Windows on
your Mac.

To install Windows software on a MacBook Air, you need an external optical drive such as

a MacBook Air SuperDrive.
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In Mac OS X, open Startup Disk preferences to select your Windows partition. In Windows,
open the Boot Camp Control Panel and then click Startup Disk.

Select the system you want to use to start up your computer

Startup Disk‘

Mac OS X, 10.6 Windows
on Macintosh HD on BOOTCAMP

You have selected Windows
on the disk “BOOTCAMP."

I—}

Network Startup

Click to restart this computer in targ:
After you restart this computer in target dis|
to another computer using a FireWire cable

d] Click the lock to prevent further chy

B Boot Camp Control Panel

Startup Disk | Brightness | Remote | Keyboard | Trackpad | Power

— Select your Windows

partition and then click
Restart.

X

Select the system you want to use to start up your computer

Select your Mac OS X

| Macintosh HD  BOOTCAMP _|

startup disk and then

Click to restart this computer in Target Disk Mode.

After you restart this computer in Target Disk Mode, you can connect it
to another computer using a FireWire cable and use it as a hard disk.

click Restart.

Target Disk Mode. ..
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Here if you need us

www.apple.com/support
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Online resources

For online service and support information, visit www.apple.com/support. Choose
your country from the pop-up menu. You can search for the latest software updates
and manuals, find answers using the AppleCare Knowledge Base, or get help from
Apple’s discussion forums.

Onscreen help

You can find answers to your questions, as well as instructions and problem-solving
information, by using the Help menu in some applications. Choose Mac Help from
the Finder Help menu, type a few words in the search field, and then press Return.

System Profiler

Use System Profiler to retrieve information about your computer. System Profiler
indicates the hardware and software installed on your computer, the serial number
and operating system version, the amount of memory installed, and how much
battery power remains. To open System Profiler, choose Apple (&) > About This Mac
from the menu bar, and then click the More Info button.



Your Mac OS X product comes with 90 days of complimentary telephone support.

AppleCare telephone support representatives can help you solve basic problems.
Contact the support center nearest you, or visit www.apple.com/support/expert to
arrange a phone call with an Apple Expert who specializes in your exact question
(not available in all countries). Have the date of purchase and your Apple computer
serial number ready when you speak to a representative.

Note: Telephone fees may apply. For more information, visit www.apple.com/
support/complimentary.

You can extend your coverage by purchasing the AppleCare Protection Plan.
For more information, visit www.apple.com/support/products.

For additional information about contacting Apple Support, visit www.apple.com/
contact/phone_contacts.html. (Telephone numbers are subject to change.)

Technical Support Numbers

United States 1-800-275-2273 www.apple.com/support

Canada 1-800-263-3394 www.apple.com/ca/support
Australia (61) 1-300-321-456 www.apple.com/au/support
New Zealand 00800-7666-7666 www.apple.com/nz/support
United Kingdom (44) 0870 876 0753 www.apple.com/uk/support
Ireland (353) 1850 946 191 www.apple.com/ie/support
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